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Introduction 

Excel and Word are the two powerhouses of the Microsoft Office family. While Word lets you 

create and edit documents, Excel specializes in letting you create, edit, and analyze data 

that's organized into lists or tables. This grid-like arrangement of information is called a 

spreadsheet.  

Some common spreadsheets include:  

Business documents like financial statements, invoices, expense reports, and earnings 

statements.  

Personal documents like weekly budgets, catalogs of your book, exercise logs, and 

shopping lists.  

Scientific data like experimental observations, models, and medical charts.  

 

Excel really shines in its ability to help you analyze a spreadsheet's data. The bottom line is 

that once you enter raw information, Excel's built-in smarts can help compute all kinds of 

useful figures. Excel's not just a math wizard. If you want to add a little life to your data, you 

can inject color; apply exotic fonts to help speed up repetitive formatting or editing chores. 

Format :    

 Format Excel 

Office 2003 and below .xls 

Office 2007, 2010,2016, 

365 

.xlsx 

 

Other Software 

Corel Calculate      IBM Lotus 123 
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1.0  The Interface 

 

* You can collapse the ribbon (as shown below) by double‐clicking any tab. Click a tab to 

pop it open temporarily, or double‐click a tab to bring the ribbon back for good. And if you 

want to perform the same trick without raising your fingers from the keyboard, you can use 
the shortcut key Ctrl+F1. 
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1.1  Creating a Basic Worksheet 

• The grid divides your worksheet into rows and columns. Columns are identified with 

letters (A, B, C…), while rows are identified with numbers (1, 2, 3…). 

 

                                  

• The smallest unit in your worksheet is the cell. Cells are identified by column and 

row. For example, C3 is the address of a cell in column C (the third column), and row 

3 (the third row).  

     

                 

• A worksheet can span an eye-popping 16,000 columns and 1 million rows.  

• When you enter information, you enter it one cell at a time. However, you don't have 

to follow any set order. For example, you can start by typing information into cell A40 

without worrying about filling any data in the cells that appear in the earlier rows. 

 

  

Row 

Column 
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Exercise 1: 

1. Download Excel Exercise  from website and click on sheet Cell number 

2. Identify Cell Number for this worksheet 

 

 Cell Number  Cell Number 

U  P  

I  PP  

T  W  

M  B  

 

3. Fill in all the alphabet cells with red color using multiple selection.(hold CTRL key while 

selecting cell) 

1.2  Insert & Delete Row/Column 

Inserting rows is just as easy as inserting new columns. Just follow these steps:  

1. Select the row that's immediately below where you want to place the new row.  

That means that if you want to insert a new, blank row between rows 6 and 7, start 
by selecting the existing row 7. Remember, you select a row by clicking the row 
number header.  

2. Choose Home >>Cells >>Insert >>Insert Sheet Rows. /or RIGHT CLICK 

Excel inserts a new row, and all the rows beneath it are automatically moved down 
one row.  
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Before Insert After Insert 

 

 

 
 

         

Exercise 2: 

1. Go to sheet Insert Row 

2. Insert a row Between Perak and Selangor and add text Perlis 

3. Insert another two rows between Johor and Pahang with Sarawak and Sabah 

4. Insert a column next to state and label with No 

5. Insert a column between State and Point and add text Name 
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1.3 Insert & Renaming Sheet 

 

Sheet1 + sheet2 +  Sheet3  =Spreadsheet 

Worksheet1 + Worksheet2 +  Worksheet 3 = Workbook 

 

 

 

 

Exercise 3 

Create worksheet as follow 
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2.0  Formatting Cell Value - Adding Different Types of Data  

Most of the time, when you enter information in Excel, you don't explicitly indicate the type 

of data. Instead, Excel examines the information you've typed in, and, based on your 

formatting and other clues, classifies it automatically. Excel distinguishes between four core 

data types:  

• Ordinary text. This data type includes column headings, descriptions, and any 

content that Excel can't identify as one of the other data types.  

• Numbers. This data type includes prices, integers, fractions, percentages, and every 

other type of numeric data. Numbers are the basic ingredient of most Excel 

worksheets.  

• Dates and times. This data type includes dates (like Oct 3, 2007), times (like 4:30 

p.m.), and combined date and time information (like Oct 3, 2007, 4:30 p.m.). You can 

enter date and time information in a variety of formats.  

2.1 Format Cells menu 

 

1. Use dialog launcher in ribbon 
 

 
 

2. Or,right click on selected cell 
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Exercise 4 – Formatting Number 

 

Identify  the result for each data entry 

Data Format Result 

32 Number (3 Decimal Place)  

1765.34 Currency (Malaysia Ringgit)  

31/8/1957 MY Date (date,month,year)  

0.4365 Percentage (2 decimal)  

13500 Special - English US ZipCode+4  

10.34 Fraction(up to 2 digits)  

 
240000000  

Number (with 1000 separator)  
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2.2 Formatting Cell Appearance - Text And Alignment 

To format a cell's appearance, first select the single cell or group of cells that you want to 

work with, and then choose Home >>Cells >>Format >>Format Cells, or just right-click 

the selection, and then choose Format Cells. The Format Cells dialog box that appears is the 

place where you adjust your settings. 

 

Exercise 4:  

 

Open a worksheet name Formatting Text  and edit based on this format using instruction 

below 

 

 
 

 

 

 

 

 

 

 

 

  

Merge Cell A1 to C1 

Rotated Text 45 
degree 

Merge Cell C7 to G8 
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2.3 Sort data in a range or table 

Sorting data is an integral part of data analysis. You might want to put a list of names in 

alphabetical order, compile a list of product inventory levels from highest to lowest, or order 

rows by colors or icons. 

 

 

TRY THIS 

Sort  

Alphabet Viewer (mil) Date On Air 

Imam Muda 2.2 19 Mei 2011 

Mentor 3.5 01 April 2012 

On Air 1.8 04 April 2012 

AF 3.2 29 Mac 2011 

MasterChef 1.6 20 Oktober 2011 

Versus 2.5 03 Februari 2012 

 

Hightlight cell and select sorting A to Z ( lowest to highest) 
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3.0 Building Basic Formulas 

 

3.1 Formula and Math Operator 

Formulas start with the equal sign (=), which tells Excel you want to perform a calculation. 

After the equal sign, you must specify two more types of information:  

• the values you want to calculate  

• the cell located the value 

• The arithmetic operator(s) or function name(s) you want to use to calculate the 

values.  

 

Formula Bar 

 

 

Excel's Arithmetic Operators 
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TRY THIS!! 

The value of area came from the value of length and width.  

So the formula is   area= length x width  [convert to Excel formula will be ] 

                                

 

Complex formulas piece-by-piece in this order: 

1. Parentheses (any calculations within parentheses are always performed first) 

2. Percent 

3. Exponents 

4. Division and Multiplication 

5. Addition and Subtraction 

Consider This , what is the answer? 

Without Parentheses (Bracket) With Parentheses (Bracket ) 

  

For example, notice how adding parentheses affects the result in the following formulas: 

5 + 2 * 2 ^ (3 - 1) = 13 
    (5 + 2) * 2 ^ 3 - 1 = 55 

    (5 + 2) * 2 ^ (3 - 1) = 28 

     5 + (2 * (2 ^ 3)) - 1 = 20 

 

Try This!! 

A B C RESULT OPERATION FORMULA 

1 2 3  ADDITION 
 

4 3 12  SUBSTRACT 
 

12 23 11  MULTIPLY 
 

8 -9 -12  DIVIDE 
 

 

  

A2 

B2 

=A2*B2 



 

©MOHD SAIFULNIZAM ABU BAKAR Page 13 

MICROSOFT EXCEL BEGINNER 

Exercise 5 

Follow this step:  

1. Merge Title from A1 to B1 

2. Highlight the cells A1, B1 and C1, and Merge the cells  

3. Your spreadsheet will look like this  

 
 

4. Click inside cell B3 of your spreadsheet, and type Monday, as in the image below:  
 

        
 
5. Position your mouse pointer to the bottom right of the B3 cell  

The mouse pointer will change to a black cross, as in the images below. The image 

on the left shows the normal white cross; the image on the right, the black cross, tells 

you AutoFill is available:  

    

 

 
6. When you can see the AutoFill cursor, hold down your left mouse button and drag  

to the right - Drag your mouse all the way to cell H3, as in the following image: \ 
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7. Finalize the table as shown below  

 

 
 
 

 
 
8. Locate cell B16 on your spreadsheet and click on it  
 

Get the total from cell I4 by entering formula =i4 
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9. To calculate profit for Maggi Kari , click into cell E16 on your spreadsheet  

 

Type the following formula: =(B16*D16)-(B16*C16) 

 

 Hit the enter key on your keyboard, and you should get an answer  

 
10. Use autofill to calculate the following rows 
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Autofill Easy 

1. Type 1 and 2 in separate cell 

2. Using arrow and shift to select both cell 

 
3. Make sure arrow is Black. 

4. Drag below to generate autofill list. 

 

Creating Custom List For Autofill 

1. File > Option 

2. Advanced > Edit Custom Lists  
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3. Type entries and click Add 

 

 
 

4. Test autofill 

 

5. You can also import from available sheet by click Add 
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Exercise 6 

Attending college is an expensive proposition and your resources are limited. To plan for your four-year college career, you have 

decided to organize your anticipated resources and expenses in a worksheet. The data required to prepare your worksheet is shown 

below. 

College Expenses 
and Resources            

            

Expenses  1st Year  2nd Year  3rd Year  4th Year  Total 

Room & Board  3390         

Tuition & Books  4850         

Clothes  540         

Entertainment  635         

Miscellaneous  325         

Total            

Resources  1st Year  2nd Year  3rd Year  4th Year  Total 

Savings  1700         

Parents  2390         

Job  1450         

Financial Aid  4200         

Total            

 
Instructions  
 

1. Create an Excel worksheet using the numbers in table above.  
2. Determine the expenses and resources for the each year by assuming that these figures will increase by 7% per year. Use an Excel 

formula to create these new figures.  
3. Create the proper sums in the rows and columns. Your expense and resource totals should be $43,245.04 
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3.2 Math and Statistical Functions 

 

3.2.1 SUM( ): SUMMING UP NUMBERS 

Here's a SUM( ) formula that adds two cells: 

 =SUM(A1,A2) 

And here's a SUM( ) formula that adds the range of 11 cells from A2 to A12: 

 =SUM(A2:A12) 

 

3.2.2 AVERAGE 

The AVERAGE( ) function uses just one argument: the cell range you want to average: 

 =AVERAGE(A2:A12) 

 

3.2.3 MAX( ) AND MIN( ): FINDING MAXIMUM AND MINIMUM VALUES 

The MAX( ) and MIN( ) functions pick the largest or smallest value out of a series of cells 

 

 =MAX(range) 
 

3.2.4 LARGE( ), SMALL( ), AND RANK( ): RANKING YOUR NUMBERS 

Both the LARGE( ) and SMALL( ) functions require two arguments: the range you want to 
search, and the item's position in the list. The list position is where the item would fall if the 
list were ordered from largest to smallest (for LARGE( )), or from smallest to largest (for 
SMALL( )). Here's what LARGE( ) looks like: 

 LARGE(range, position) 
 

For example, if you specify a position of 1 with the LARGE( ) function, then you get the 
largest item on the list, which is the same result as using MAX( ). If you specify a position of 
2, as in the following formula, then you get the second largest value: 

 =LARGE(A2:A12, 2) 
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SMALL( ) performs the opposite task by identifying the number that's the smallest, second-
smallest, and so on. For example, the following formula gives you the second-smallest 
number: 

 =SMALL(A2:A12, 2) 
 

The RANK( ) function requires two parts: the number you're looking for and the range you're 
searching.  

For example, imagine you have a range of cells from A2 to A12 that represent scores on a 
test. Somewhere in this range is a score of 77. You want to know how this compares to the 
other marks, so you create the following formula using the RANK( ) function: 

 =RANK(77, A2:A12) 
 

3.2.5 COUNT( ), COUNTA( ), and COUNTBLANK( ): Counting Items in a List 

COUNT( ) function counts the number of cells that have numeric input (including dates). The 

COUNTA( ) function counts cells with any kind of content.  

And finally, the COUNTBLANK( ) function takes a single argumenta range of cellsand gives 

you the number of empty cells in that range 

Here's how you could use the COUNT( ) function with a range of cells: 

 =COUNT(A2:A12) 
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Exercise 7 

 

Go to sheet Exe 7-Math and get the answer 

     

Write the formula  

 
Answer Formula 

Average   

Max   

Min   

Second Largest   

Third Lowest   

Rank 66   
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3.5 Count Item  

 

 

 

3.5.2 COUNT 

 

The COUNT function counts the number of cells that contain numbers, and counts numbers 

within the list of arguments. Example :  count the numbers in the range  

=COUNT (A3:i11) 
 

3.5.3 COUNTIF 

 

The COUNTIF function counts the number of cells within a range that meet a single criterion 

that you specify 

=COUNTIF(A3:i11,"55") 
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Find COUNTIF function >go and select COUNTIF 

 

 

 

 

3.5.3 FREQUENCY 

 

Calculates how often values occur within a range of values, and then returns a vertical array 

of numbers. For example, use FREQUENCY to count the number of test scores that fall within 

ranges of scores. Because FREQUENCY returns an array, it must be entered as an array 

formula. 

FREQUENCY(data_array,bins_array) 

1. Add bin to your worksheet 
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2. Highlight all cell in frequency 

 
 

3. Insert Function > type frequency and click go 
 

 
 

4. Select frequency function and click OK 
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5. Insert cell range for type of data array and bin array 
 

 

              

6. PRESS   CTRL+SHIFT+ENTER 

 
7. The result will be updated 
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3.5.4 SUMIF  

The SUMIF function is used to add up the values in cells in a selected range that meet certain 

criteria. 

The syntax for the SUMIF function is: 

= SUMIF (Range, Criteria, Sum Range) 
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4.0  Decision Making 

You can compare two values with the following operators. When two values are compared 

by using these operators, the result is a logical value either TRUE or FALSE. 

 

 

4.1  IF FUNCTION 

The IF function returns one value if a condition you specify evaluates to TRUE, and another 

value if that condition evaluates to FALSE. For example, the formula =IF(A1>10,"Over 10","10 

or less") returns "Over 10" if A1 is greater than 10, and "10 or less" if A1 is less than or equal 

to 10. 

 

If mark >=50 then status (PASS)   , if <50 then status (FAIL) 

=IF(B2>=50;"PASS";"FAIL") 

1. Select IF function 
 

 
 

2. Insert logical test and value TRUE / FALSE 
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3. Using AUTOFILL to get the status for all students ( drag to the bottom) 
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4.2 Multiple IF Function 

Consider Student Exam problem. The spreadsheet we created to track student’s mark 

 

However, we want to display the following grades as well:  

• A If the student scores 75 or above  

• B If the student scores 60 to 74  

• C If the student scores 47 to 59  

• D If the student scores 40 to 46  

• F If the student scores below 39 

You are actually combined 4 IF statement in single formula 

Condition IF statement 

A =IF(B3>=75; "A"; 
B   IF(B3>=60;"B"; 
C   IF(B3>=47; "C"; 
D   IF(B3 >=40;"D"; 
F       "F" ) ) ) ) 

 

Can you see the pattern? if you have 4 if statements, there will be 4 brackets at the end of 
formula 
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=IF(B3>=75, "A", IF(B3>=60,"B",IF(B3>=47, "C", 

IF(B3 >=40,"D", "Fail" ) ) ) ) 

 

 

 

The result  
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Using COUNTIF function, please add the following table below 

 

 

=COUNTIF(B12:B17,"A")           =COUNTIF(B12:B17,"B") 

=COUNTIF(B12:B17,"C") 
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4.3 VLOOKUP 

Use VLOOKUP, one of the lookup and reference functions, when you need to find things in a 

table or a range by row. For example, look up a price of an automotive part by the part 

number. 

 

=VLOOKUP(value, table, column) // default, approximate match 

=VLOOKUP(value, table, column, TRUE) // approximate match 

=VLOOKUP(value, table, column, FALSE) // exact match 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://exceljet.net/excel-functions/excel-vlookup-function
https://exceljet.net/excel-functions/excel-vlookup-function
https://exceljet.net/excel-functions/excel-vlookup-function
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=VLOOKUP(I3,B3:E13,2,FALSE)     - COLUMN NO 2 

 

 
 

VLOOKUP From Another Sheet 

 

=VLOOKUP(lookup,sheet!range,column,match) 

 

Change sheet in Table Array 

 

 

 

 

Press ENTER after selecting Sheet & Data Set 

 

 

 

https://exceljet.net/excel-functions/excel-vlookup-function
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Excel HLOOKUP Function 

 

HLOOKUP is an Excel function to lookup and retrieve data from a specific row in table. The 

"H" in HLOOKUP stands for "horizontal", where lookup values appear in the first row of the 

table, moving horizontally to the right. HLOOKUP supports approximate and exact matching, 

and wildcards (* ?) for finding partial matches. 
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4.4 Create Form with Drop Down List 

1. Go to sheet FORM LIST 

2.  Type a list in Excel such as State in Malaysia 

 
3. Select E2 cell. 

4. Data > Data Validation 

 
 

5. Select List 
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6. Click Source > Select All State in the sheet. 

 
 

7. Press OK 

 

 
 

8. Check the list 

 

  



 

©MOHD SAIFULNIZAM ABU BAKAR Page 37 

MICROSOFT EXCEL BEGINNER 

5.0  Chart 

Charts are used to display series of numeric data in a graphical format to make it easier to 
understand large quantities of data and the relationship between different series of data. 

To create a chart in Excel, you start by entering the numeric data for the chart on a 
worksheet . Then you can plot that data into a chart by selecting the chart type that you want 
to use on the Office Fluent Ribbon (Insert tab, Charts group). 

 

Worksheet data 

Chart created from worksheet data 

 

Excel supports many types of charts to help you display data in ways that are meaningful to 
your audience. When you create a chart or change an existing chart, you can select from a 
variety of chart types (such as a column chart or a pie chart) and their subtypes (such as a 
stacked column chart or a pie in 3-D chart). You can also create a combination chart by 
using more than one chart type in your chart. 

 

 

 

 

 

 

 

 



 

©MOHD SAIFULNIZAM ABU BAKAR Page 38 

MICROSOFT EXCEL BEGINNER 

5.1  Getting To Know The Elements Of A Chart 

 

The chart area  of the chart. 

The plot area (plot area: In a 2-D chart, the area bounded by the axes, including all data 
series. In a 3-D chart, the area bounded by the axes, including the data series, category 
names, tick-mark labels, and axis titles.) of the chart. 

The data points (data points: Individual values plotted in a chart and represented by bars, 
columns, lines, pie or doughnut slices, dots, and various other shapes called data markers. 
Data markers of the same color constitute a data series.) of the data series (data series: 
Related data points that are plotted in a chart. Each data series in a chart has a unique color 
or pattern and is represented in the chart legend. You can plot one or more data series in a 
chart. Pie charts have only one data series.) that are plotted in the chart. 

The horizontal (category) and vertical (value) axis (axis: A line bordering the chart plot 
area used as a frame of reference for measurement. The y axis is usually the vertical axis 
and contains data. The x-axis is usually the horizontal axis and contains categories.) along 
which the data is plotted in the chart. 

The legend (legend: A box that identifies the patterns or colors that are assigned to the 
data series or categories in a chart.) of the chart. 

A chart and axis title (titles in charts: Descriptive text that is automatically aligned to an 
axis or centered at the top of a chart.) that you can use in the chart. 

A data label (data label: A label that provides additional information about a data marker, 
which represents a single data point or value that originates from a datasheet cell.) that you 
can use to identify the details of a data point in a data series. 
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TRY THIS 

1. Create the table below and convert it into chart at your own choice 

Country Gold Silver Bronze 

China 38 45 71 

USA 34 56 55 

Korea 28 28 23 

Germany 28 21 13 

France 26 35 55 

 

2. Highlight (select) country and medal tally 

               

3.  On the Insert tab, in the Charts group, do one of the following:  

• Click the chart type, and then click a chart subtype that you want to use.  

• To see all available chart types, click a chart type, and then click All Chart Types to display 
the Insert Chart dialog box, click the arrows to scroll through all available chart types and 
chart subtypes, and then click the ones that you want to use. 
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What you can do on the chart 

1. Change the layout,format and title of chart elements manually 
 

 
 
 
 

 

 

 

 


